OER Accessibility Series: Document Design

There are lots of little particulars when designing documents for accessibility, and the easiest and
most user-friendly way to comply with them is to design with Microsoft Word. As you go through
this guide, you may ask yourself why it matters that you use the built-in functions, if the screen
reader will read the text anyway? Well, you're right that that the text will be read. However, the
formatting won't be unless it is designed properly. Things like headings, lists, and tables are only
visible to the screen reader and read correctly by it if they are used and designed correctly. This
guide will cover the essential functions of Microsoft Word for accessibility.

Don’t forget to review the Document Design, Alternative Text, and Captioning and
Transcripts guides for additional accessibility compliance considerations.
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Creating Accessible Heading Structure in MS Word

Heading structure is essential to accessible documents because it tells the screen reader when to
tell the student that they are starting a new section of the document. Imagine listening to an
audiobook, and instead of the reader pausing when they read the next chapter title, they just went
straight from the end of the previous chapter to the chapter title to the chapter text, all in one
breath. Well, that's what it is like when a person using a screen reader doesn't have heading
structure in the documents they need to read.

The importance of heading structure goes beyond just first-level headings, however. Nested
headings are equally as important because it helps the screen reader keep the page organized for
the user. If there are multiple subheadings within an upper-level heading, the screen reader will tell
the user what level it is so that they can keep up and stay organized.

1. With your document open in MS Word, select the “Home” tab on the ribbon.
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Chapter Objectives
Upon completion of this chapter, readers will be able to:
1. Define technical writing.
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3. The “Styles” panel will emerge from the right side of the screen. This panel contains all of the
standard default styles plus any additional styles in your document. The default styles are the
ones we want to use, but don't worry! You can customize them to look the way you want.
Start by highlighting the first heading in your document, then click “Heading 1.”
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4. You'll notice that, unlike in our example images, the default for heading one is a larger Calibri
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5. From the window that pops up, you can customize your Heading 1 font style to be anything
you want it to be—just keep readability and color contrast in mind.
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who lack communication and interpersonal skills (White, 5013).

For nested headings (i.e. subheadings within headings), consider the heading number to be the
heading level. So, first-level headings should be “Heading 1,” second-level subheadings (within
Heading 1) should be “Heading 2,” third-level subheadings (within Heading 2) should be “Heading 3.”
Most of the time, you will have one “Heading 1" per document, unless you are writing something
large, like a textbook—in that case, you would have one “Heading 1" per chapter (the chapter title).
Then from there, you may have any number of “Heading 2,” “Heading 3,” etc. Proper nesting and
using the “Styles” feature are essential to document accessibility.
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Creating Accessible List Structure in MS Word

List structure in MS Word is easy, and most of us do it the correct way anyway. To create accessible
lists that will be ready as lists by a screen reader, just make sure you are using the list functions in
Word and that you are using the correct type of list.

A bulleted list is for unordered lists—the order the items are in doesn’t matter. There is no
hierarchy, and they are not steps. They could be read in any order and the meaning would not
change.

A numbered or lettered list is for ordered lists—the order the items are in does matter. There is
some kind of hierarchy or they are steps to a process. If they are read in the wrong order, the
meaning would change.

Make sure that you are using the list feature when it's appropriate to. While the grammatical
structure of a list within a sentence may be correct, if the list is too long, it becomes hard to read
and remember what the list is actually about.

For accessible lists, use the list function in MS Word, on the “Home” ribbon, in the “Paragraph”
section.
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Creating Accessible Tables in MS Word

When creating tables in MS Word, you want to keep a few things in mind to make sure they are

accessible.

Screen readers are very particular about how they read tables. For that reason, you should never
use a table for anything other than for stuff that belongs in a table (meaning that you don’t want to
use invisible tables for formatting, like many of us have done in the past).

Header rows are essential in tables, and you want them to repeat at the top of each page (for multi-
page tables). And just as with headings and lists, using the styles provided by Word for tables is
your best bet, but they can still be customized. Once you create your table, you can set these

settings with just a few steps.

Cllck on your header row, then right click and choose “Table Properties.”
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Click the table, then click the “Design” tab under “Table Tools” on the ribbon.
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Provide topic indicators at the beginning of paragraphs. Analyze
some of the letters you see in this chapter in terms of the contents or purpose of their
individual paragraphs. In the first sentence of any body paragraph of a business letter,
try to locate a word or phrase that indicates the topic of that paragraph. If a paragraph
discusses your problems with a personal computer, work the word "problems" or the
phrase "problems with my personal computer” into the first sentence. Doing this gives
recipients a clear sense of the content and purpose of each paragraph. Here is an
excerpt before and after topic indicators have been incorporated:

=

Problem
| have worked as an electrician in the
Decatur, lllinois, area for about six years.

Revision
As for my work experience, | have
worked as an electrician in the Decatur,

On the left side of the ribbon, make sure that “Header Row” is checked, and if appropriate,
check “First Column’

" (if you also have headers going down the table on the left side).
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Provide topic indicators at the beginning of paragraphs. Analyze
some of the letters you see in this chapter in terms of the contents or purpose of their
individual paragraphs. In the first sentence of any body paragraph of a business letter,
try to locate a word or phrase that indicates the topic of that paragraph. If a paragraph
discusses your problems with a personal computer, work the word "problems" or the
phrase "problems with my personal computer” into the first sentence. Doing this gives
recipients a clear sense of the content and purpose of each paragraph. Here is an
excerpt before and after topic indicators have been incorporated:

| Problem

| Revision |
‘ | have worked as an electrician in the

| As for my work experience, | have |

5. You can play around with the table design from this tab as well, using the other features

available. You

can also play with the style of the table from the “Layout” tab under “Table

Tools” on the ribbon.
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Provide topic indicators at the beginning of paragraphs. Analyze
some of the letters you see in this chapter in terms of the contents or purpose of their
individual paragraphs. In the first sentence of any body paragraph of a business letter,
try to locate a word or phrase that indicates the topic of that paragraph. If a paragraph
discusses your problems with a personal computer, work the word "problems" or the
phrase "problems with my personal computer” into the first sentence. Doing this gives
recipients a clear sense of the content and purpose of each paragraph. Here is an
excerpt before and after topic indicators have been incorporated:

F

|

Problem Revision

| have worked as an electrician in the
Decatur, lllinois, area for about six years.
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Creating Accessible Links in MS Word

We are often tempted to place the URL for a website into our documents as a link because it
ensures that if our link doesn’t work, the user can copy and paste the URL into their browser and
still find the page. It's a smart back-up plan, but it's often done without keeping accessibility in mind.
When a screen reader reads a link, it reads the link text, followed by the URL. However, if there is no
descriptive link text, it will only read that URL. | mean, we have all been taught never to click on a
link that we don't know where it goes, right?

To make our links accessible, they need to be descriptive—instead of reading as the URL, they
should read as an explanation of where the link goes. For example:

Accessible: Affordable Learning Georgia

Not Accessible: https://www.affordablelearninggeorgia.org/

Of course, that doesn't mean we can't include the URL as well. There just needs to also be an
accessible version of our links. Our suggestion is to use the accessible version as your primary link,
and then provide the URL as an alternative. For example:

You can learn more about Textbook Transformation Grants on the Affordable Learning
Georgia website. You can also access the website by copy/pasting the URL here:
https.//www.affordablelearninggeorgia.org/

It's pretty easy to create accessible links:

1. Type the description of the link, then highlight it. Click the “Insert” tab on the ribbon, then

" Ll n k "
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Create a link in your document for
quick access to webpages and files.

Hyperlinks can also take you to
places in your document.

Accessibility in Technical Writing @ T memer

Accessibility is perhaps the most important standard for excellence in technical
communication. At the very least, the design of your document should be useful, easy
to navigate, and with all information easy to locate. Specifically, websites and e-
learning documents must meet ADA (American Disabilities Act) laws for accessibility.
The link below will provide more information about ADA for you.

What is the Americans with Disabilities Act (ADA)?

What's Next? Let’s Get Started!

Nobody wants to read anything you have written.
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2. Type or paste the URL into the box provided, and then click “OK.”

Accessibility in Technical Writing
Accessibility is perhaps the most important standard for excellence in technical
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3. Confirm that your link is functional by holding down the CTRL key and clicking the link.

Accessibility in Technical Writing

Accessibility is perhaps the most important standard for excellence in technical
communication. At the very least, the design of your document should be useful, easy
to navigate, and with all information easy to locate. Specifically, websites and e-
learning documents must meet ADA (American Disabilities Act) laws for accessibility.
The link below will provide more inform

httpsi//adata.org/lear-about-ada
Ctrl+Click to follow link

What is the Americans with Disabilities Alct (ADA)?|

What's Next? Let’s Get Started!

Nobody wants to read anything you have written.

- So how can you make sure they will? Say what? After years of having willing and
captive audiences (i.e. your mom and your teachers) for every word you put on paper,
B we are telling you that nobody wants to read what you have written? Yep. They don't
want to, but they have to. Technical or workplace writing is intended to solve problems,
seek solutions, and provide necessary information that workers will use to, well, solve
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